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PREFACE

Welcome to the Oracle Insurance Insbridge Enterprise Rating IBER Upgrade Guide. The Insbridge
Enterprise Rating (IBER) System is a browser-based, multiplatform insurance rating and underwriting
technology solution that provides integrated management for every aspect of the rate definition and
modification process. The purpose of this guide is to assist with the upgrading of the Insbridge Enterprise
Rating System.

There are different types of upgrades available to the 04.08.00 release of the IBER system:

o RateManager/IBFA

SoftRater for Windows

SoftRater for WebLogic

SoftRater for WebSphere

SoftRater for JBoss

This document focuses on upgrading RateManager/IBFA and SoftRater for Windows. Also included are
the steps for upgrading SoftRater for WebLogic, WebSphere, and JBoss.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others tasked
with installing and configuring the IBER system and associated databases.

TYPES OF INSTALLATION

There are various types of installations:

RateManager Installation

o RateManager for Windows — Installs RateManager and the Insbridge Framework Administrator
(IBFA) in a Windows environment and utilizes IBFA for local rating. This Windows only
environment uses a SQL Server database.

SoftRater Installation

o SoftRater for Java Installation — Deploys Insbridge SoftRater Server (IBSS) to an application
server; WebLogic, WebSphere, or JBoss, using a SQL Server database, or an Oracle database,
or a DB2 database.
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o SoftRater for Windows Node — This installation is for existing environments that want to add a
SoftRater for Windows node to an environment. This is for a Windows only environment using a
SQL Server database.

Upgrading a Current Installation

o Upgrade — Upgrades existing customers from their current version of IBER up to version
04.08.00.

This guide describes Upgrading an existing environment.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Enterprise Rating
system:

o IBER: Inshridge Enterprise Rating System. This is the entire system.

e IBFA: Insbridge Framework Administrator. IBFA is an administrative tool used to configure
Insbridge applications and setup RateManager database connections. IBFA will be located on a
Windows Server machine. IBFA/SR-WIN is an Insbridge Framework Administrator/SoftRater for
Windows.

o IBSS: Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater engine. The
SoftRater engine is a multi-platform component within IBER that executes the rules, rating and
underwriting instructions as defined by the user in RateManager. IBSS is usually located on a
Java machine. IBSS/SR-JAVA is an Insbridge SoftRater Server/SoftRater for Java.

e SoftRater Node: A SoftRater node is either an IBFA (without RateManager) or IBSS instance on
a physical environment.

o SoftRater Native: SoftRater Native is a remote instance of SoftRater that can execute rules and
rating logic in environments where access via the SoftRater web-services is not desired or
possible.

¢ RM: RateManager. RateManager is a component within IBER that enables users to manage the
product definition and modification process, including rating and underwriting logic.

e SR: SoftRater. The engine that executes the rating, rules and underwriting instructions defined
within RateManager. The rating environment for runtime execution and processing of business
content. SoftRater can be further defined by the operating system where it has been loaded.

e SR-WIN: SoftRater for Windows. This is also another name for IBFA.

e SR-JAVA: SoftRater for Java. This is also another name for IBSS.

o SRP: SoftRater Packages. A package that holds all the RateManager logic for a specific program
and version.

e VFS: Virtual File Servers. Virtual file server management allows you to access environments that
are located on other machines in different locations where packages can be downloaded.
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Package Location: A pointer to a location where SoftRater Packages (SRP’s) are stored.
Physical Environment: A physical environment is generally referred to as a physical machine.
Authoring Environment: The physical machine where RateManager is installed.

Rating Environment: The physical machine(s) where SoftRater is installed. This is typically the
same as a SoftRater node.

Logical Environment: An environment created for a subscriber in IBFA. It defines package
location, engine location and database location in addition to several other supporting data items.
This environment is used for rating and/or SRP management. Each database connection will
have a logical environment.

Related Documents

For more information, refer to the following Oracle resources:

The Oracle Insurance Insbridge Enterprise Rating Operating Environments for Hardware and
Software.

You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

Manual History

New editions incorporate any updates issued since the previous edition.

Publication Product

Edition . Publication Date Comment
Number Version
~1% Edition P01-788-01 May 2011 Initial Release
2" Editon  P01-788-02 R 4.5.1 September 2011  Update
3 Edition  P01-788-03 R 4.6 May 2012 Update
4" Editon  P01-788-04 R 4.6.1 November 2012  Update
5" Editon  P01-788-05 R 4.7.0 September 2013  Update
6" Edition ~ P01-788-06 R 4.7.1 November 2013 Update

7" Edition  P01-788-07 R 4.8 August 2014 Update
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Chapter 1

SYSTEM UPGRADE REQUIREMENTS

Prior to upgrading an IBER system, please have ready:

The Insbridge User Account information.
The location of the current IBER installation.

The Insbridge User has administrative rights or proper permissions to run an installation and start
the Insbridge Message Service and the Insbridge Task Manager Service.

You must run as Administrator for a Windows 2008 Server upgrade.
Administrator User name and password for RateManager.
OR

Access to the IBER databases. Updates are run against the IBRM and the IB_CLIENT
databases. SoftRater databases may not require an update.

NOTE:

Upgrades are performed the same way for either a 32-bit machine or a 64-bit machine. The same
permissions and requirements are needed and should already be set up.

Oracle Software Delivery Cloud

Prior to installation, please make sure the source machine(s) where IBER will be loaded has an unzip
utility. An unzip utility for most platforms is available on the Oracle Software Delivery Cloud download

page.

Documentation from Oracle Software Delivery Cloud is in PDF format. Prior to installation, please make
sure the source machine(s) where IBER documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers you have
downloaded and the corresponding file name. You may be asked to provide the part numbers or the
filename if you contact Oracle Insurance Support.

The installation downloads you can select are:

Insbridge IBER Install: Required for all RateManager installations. There are two options for the
IBER install, 32-bit or 64-bit. Please be sure you have downloaded the correct install for your
machine.

SoftRater for WebSphere: Required if you are using WebSphere

SoftRater for WebLogic: Required if you are using WebLogic

SoftRater for JBoss: Required if you are using JBoss
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o Documentation: It is recommended that you download the documentation. Installation guides
and user guides are located here.

The 04.08.00-Insbridge-IBER folder contents:

- Databases
¢+ DB2
- SoftRater: IBSR
o DDLs
0 Update: usp_IBSR_v04.07.00.db2
¢ Oracle
- SoftRater: IBSR
o DDL
o0 Update: usp_IBSR_v04.07.00.oracle
¢ SQL Server
- RateManager: IBRM
0 Latinl_General_BIN
= DATABASE BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security: IB_CLIENT
0 SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater: IBSR
0 Latinl_General_BIN
» DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IBSR_TEMPLATE.bak
o Update: usp_IBSR_v04.05.01.sq!
o Update: usp_IBSR_v04.06.00.01.sql
o Update: usp_IBSR_v04.08.00.00.sq]l

- IE7_IE8 Users
¢ Insbridge RateManager Setup Document PDF
¢ RateManager_|E7_IE8.exe

- Oracle Bl Publisher
¢ OBI_PUBLISHER.exe

- Oracle Client
¢ Oracle_client.exe

- Oracle Insurance Insbridge Enterprise Rating.exe

The 04.08.00-Insbridge-jboss folder contents:

- IBSS.EAR
- Insbridge.net.softraterconfig.xml

The 04.08.00-Insbridge-was folder contents:
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- IBSS.EAR
- Insbridge.net.softraterconfig.xml

The 04.08.00-Insbridge-wbl folder contents:

- IBSS.EAR
- Insbridge.net.softraterconfig.xml

SoftRater can be installed any time after the Insbridge Framework Administrator and RateManager have
been installed. SoftRater must be installed prior to any users creating packages. Please note, all folders
and files may not be needed, depending upon the kind of setup you want.

ADMINISTRATIVE USER ACCOUNTS

No administrative account is created when IBER is installed. An administrative user account must be
created on the server where the IBER system is going to be installed. This required account is the
Insbridge Local User Account.

The Insbridge Local User needs to be a member of the User group and requires certain privileges in order

to fully control the entire IBER environment. For ease of installation and if the server is dedicated to the
Insbridge Enterprise Rating System, this user can be added to the local machine Administrators group.

FILE PERMISSIONS

The Insbridge User requires read/write permissions on:

e The Windows Temp Folder. This is necessary for MSMQ.

e The Insbridge Application Pool Identity

e The Insbridge Folder

The Insbridge user must also be given full control over the following registry key:

e HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge

Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.
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Insbridge User Password

The password can be set to any password that meets your company standards. The IBER administrator
must make note of the password for future configuration.

For ease of maintenance, the IBER user should not have to change the password and the password
should never expire.

The installation automatically applies the Insbridge user name and password to the necessary libraries,
virtual directories and, if used, Internet Proxy settings in IBFA. If you change the Insbridge user password,
you will have to change the password in all three of the Insbridge Com+ libraries, all three of the Insbridge
virtual directories and, if you are using it, the Internet Proxy settings in IBFA.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries, virtual directories and if you are using it, the Internet Proxy
settings in IBFA after you change your password. You also may re-install the application. This
recreates the COM+ applications, virtual directories and IBFA instance with the updated Insbridge
user password. Be aware that re-installing the application may also reset security settings in
IBFA.

Installer Permissions

The installation program requires that the installer have administrator rights on the machine where the
install is occurring. The install must be run as administrator.

NOTE: If the Installer has permissions, an Insbridge User account can be created from within the install.
If you create an Insbridge user from the install, you may not be able to set the permissions you
need. Please be sure to verify the proper permissions are in place before continuing.

Application Server Permissions

WebLogic, WebSphere, and WebLogic require read/write permissions on the server and the application
to create Insbridge specific folders, edit configuration files, and write log files.

DATABASE USER ROLES AND PERMISSIONS

If a more granular approach is required for management of security of the IBER databases, then the
following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Enterprise Rating System will fail. An experienced database administrator’s expertise is highly
recommended before making any security changes.

12



Recommended RateManager Permissions:

It is recommended that the IBRM and IB_CLIENT database user have:

A database owner (db_owner) role. db_owner access is needed to execute the Insbridge
stored procedures and have full access to the Insbridge schema.

Disk Admin permissions are also recommended in order to create backups within
RateManager.

For the IBRM and IB_CLIENT databases, if db_owner permissions are not possible, the database will
need to be updated manually. If disk admin permissions are not allowed, backups will have to be done
outside of RateManager.

Recommended SoftRater Permissions:

The recommended permissions are required for new tables to be created in the SoftRater (IBSR)

database dynamically when or if a new line of business SRP (SoftRater Package) is loaded to the
SoftRater system. If the recommended permissions are not possible, manual steps will need to be
performed that will allow for packages to be loaded.

SoftRater can utilize three database types, SQL Server, DB2 and Oracle.

Insbridge SoftRater SQL Server Database.

It is recommended that the Insbridge login be granted permission to connect to the database
engine and be enabled. It is also recommended that the Insbridge login be mapped to the
Insbridge database with the db_owner role checked.

Insbridge SoftRater Oracle Database.

It is recommended that the Insbridge user be granted, as defaults, the “CONNECT” and
“RESOURCE” Roles.

Insbridge SoftRater DB2 Database.

It is recommended that the Insbridge user be granted, as defaults, the “Connect to database”,
“Create Tables”, and “Create packages” authorities.

It is recommended that the databases be on separate machines from the applications due to performance
and security issues. The IBRU applications and databases can be tenants in a larger setup. No known
conflicts exist between IBRU and other applications or required server settings.

It is recommended that db_owner permissions be given to the Insbridge user. This will allow scripts to be
run automatically when a new package is loaded for a new line of business. If this is not possible, DT
scripts for each new line will have to be run manually before the package can be loaded.

13
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Microsoft SQL Server

JDBC Driver Class

“com.microsoft.jdbc.sqlserver.SQLServerDriver”

Supported Versions — 2005 SP/2 and 2008 R2

User Account Requirements

Create Table
Create Index
Execute on the SoftRater User Defined Stored Procedures

Oracle

SoftRater database schema is support by all available ORACLE database platforms.

JDBC Driver Class

“oracle.jdbc.driver.OracleDriver”
Using prefix jdbc:oracle:thin:

Supported Versions — 10g, 11g

User Account Requirements

Create Table
Create Index
Query access to “SYS.0OBJ$"

IBM DB2

SoftRater database schema is supported on version 9.5.

JDBC Driver Class
“com.ibm.db2.jcc.DB2Driver”
For Native AS400 — “com.ibm.as400.access.AS400JDBCDriver”

Supported Version — 9.5

User Account Requirements

Connect to database

Create Table

Create Packages

Query access to “SYSIBM.SYSTABLES”

14



Configuration Settings

Required

The query dynamics of the SoftRater system requires some modification to Configuration
settings. The following Performance Configurations parameters required to the target SoftRater
database.

Instance Level — ASLHEAPSZ >= 1024

Instance Level - QUERY_HEAP_SZ => 10240

Database Level - APPLHEAPSZ >= 1024

Recommended

The query dynamics of the SoftRater system will benefit from the following modification to
Configuration settings.

Instance Level — INTRA_PARRALLEL (Yes) — For Symmetrical Processing Machines (CPU >=2)

Database Level — DFT_DEGREE (-1) — For Symmetrical Processing Machines (CPU >=2). Allow
the optimizer to determine the degree of intra-partition parallelism based on the number of
processors and the type of query.

15



Quick View

UPGRADING RATEMANAGER, IBFA AND SR-WIN

The machine where Insbridge is located needs to be rebooted prior to upgrading. Rebooting is
necessary to assure that com+ settings are properly updated, Insbridge services are properly
stopped and all users are logged off.

Windows should be up and running prior to upgrading.

This update takes RateManager and the corresponding IBFA from 4.0 or later to release 04.08.00.

Steps to Upgrade RateManager/IBFA:

Every upgrade requires:

e Step 1. Reboot system

e Step 2: Run the IBER exe to update the application.

e Step 3: Start Insbridge Message Service.

e Step 4: Login to RateManager and perform IBER database updates.
e Step 5: Update Preferences.

NOTE: Updates can be performed manually, if desired. Manual updates are performed directly in SQL Server.

Additional Step to Upgrade RateManager/IBFA:

You will need to run this step if you are currently running release 4.7.0 or previous:

This step updates the OBI Publisher in RateManager and the corresponding IBFA from 4.7.0 or previous
to release 04.08.00 and assures that OBI is available to users.

e Step 1: Enter OBI Security Information

Additional Step to Upgrade RateManager/IBFA:

You also will need to run this step if you are currently running release 3.13.7 or previous:

This procedure takes RateManager and the corresponding IBFA from 3.13.7 or previous to release
04.08.00 and assures that previous workfiles are available to users.

e Step 1. Migrate Workfiles.
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Steps to Upgrade SoftRater for Windows from a Previous Release:

This procedure takes a SoftRater for Windows node from a previous version to release 04.08.00. This
setup must utilize SQL Server.

Step 1: Reboot system
Step 2: Run the IBER exe to update the application.
Step 3: Start Insbridge Message Service.

Step 4: Run the required SQL script manually on the SQL Server database. SoftRater database
updates are not available from RateManager.

Step 5: Update Preferences. Make any updates to Preferences at this time.

Additional Step to Upgrade SoftRater for Windows from a Previous Release:

You will need to run this step if you are currently running release 4.7.0 or previous:

This step updates the OBI Publisher in SoftRater for Windows node from 4.7.0 or previous to release
04.08.00 and assures that OBl is available to users.

Step 1: Enter OBI Security Information
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Every upgrade requires:

e Step 1: Reboot system

e Step 2: Run the IBER exe.

e Step 3: Start Insbridge Message Service.

e Step 4: Login to RateManager and perform IBER database updates.
e Step 5: Update Preferences.

NOTE: Updates can be performed manually, if desired. Manual updates are performed directly in SQL Server.

This procedure takes RateManager and the corresponding IBFA from 4.0 or later to release 04.08.00.

STEP 1 — REBOOT SYSTEM

The machine where Insbridge is located needs to be rebooted prior to upgrading. Rebooting is
necessary to assure that com+ settings are properly updated, Insbridge services are properly
stopped and all users are logged off.

Windows should be up and running prior to upgrading.
If the Insbridge Message Service is set to automatic, you must stop the service prior to running the install.

Failure to stop the Insbridge Message Service may result in the upgrade not completing properly.

Failure to Shut Down Com + Services:

Failure to shut down Com + Services may result in a configured identity error message when users
access RateManager. Users may receive an error message that an incorrect username and password are
being used or remote access is not allowed.

To correct reboot the server where the IBER System was installed. When Windows is up and running, run
the IBER executable to remove the IBER system. Rerun the IBER executable again to re-install.

To verify Com+ was updated, enter Com+ and verify the Identity of each of the Insbridge Com+ Services
is the Insbridge user. The Identity can be found on Properties->ldentity.

NOTE: The Insbridge Com plus services are started when users access the system.
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Failure to Shut Down Insbridge Message Service:

Failure to shut down the Insbridge Message Service may result in an error message being displayed
during installation and failure to completely install the required Insbridge executable. The best way to
ensure the Insbridge Message Service has completely shutdown is to reboot the system.

i'é'a Oracle Insurance Insbridge Setup | x| |

Files In Use {:)RAC'_E

Saome filez that need ta be updated are currently in use. INSURANCE

The fallowing applications are uzing files that need ta be updated by thiz zetup.

Inshridge hMessagellueue Senice

&+ futomatically close all applications and attempt to restart them after setup is complete.
" Do not cloze applications. [& reboot wil be required. |

YWize Installation Wizard [R]

Cancel |

Figure 1 Insbridge Message Service Running During Update

Failure to Use Correct Install Package:

Failure to run the correct installation package will result in an error message. To correct, download the
installation package for the machine you have.

i't‘!:l‘ Installer Information |

Pleaze inztall the Inzbridge Rating and Undenariting =64
ifztalation far B4 bit platfarms.
g

Figure 2 Failure to User Correct Install Package
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STEP 2 — RUNNING THE IBER APPLICATION

An update to the IBER system is run from the Oracle Insurance — Insbridge Enterprise Rating.exe.

Unzip the IBER folder on the machine where the IBER system (IBFA and RateManager) is currently
installed.

1. Begin with the Oracle Insurance - Insbridge Enterprise Rating Install file.

2. Open the Oracle Insurance — Insbridge Enterprise Rating file. A Welcome screen is displayed.

i'él‘ Oracle Insurance Insbridge Setup M =] |

4 Oracle Insurance Insbridge

It iz gtrangly recommended that you exit all Windows programs befare running this zetup program.

Click Cancel to quit the setup program, then cloze any programs pou have running. Click Mest to
continue the installation,

WARMIMG: This program iz protected by copenght law and international treaties.

Unauthonzed reproduction or diztibution of this program, ar any portion of i, may result in severe
civil and criminal penalties, and will be progzecuted to the maximum extent poszible under law.

ORACLE
INSURANCE

¢ Back

Cancel |

Figure 3 Installing Insbridge

3. Click on Next to continue.
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fit Oracle Insurance Insbridge Setup I =] |
Destination Folder DRACLE'
Select a folder where the application will be installed.
PR INSURANCE

T he Wize Installation ‘wfizard will inztall the files for Oracle Insurance Inzbridae in the
following falder. An upgrade or a patch will install the application o the previous
inztallation path.

Y'ou can choose nob ta install Oracle Inzurance [nsbridge by clicking Cancel to exit the
Wize [nstallation ‘wizard.

CAPROGRAM FILESAORACLEMGRUMMSEBRIDGEY

" Destination Folder

YWize Inztallation Ywizard [R]

Figure 4 Destination Location for Update

4. The destination path is displayed next. This is an information only screen. No changes are allowed.
Click Next.
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fit Oracle Insurance Insbridge Setup I =] |

Logon Information DRACLE‘

The following logon information is uzed by Insbridge. INSURANCE

Specify a uzer account bo be wzed by the application, either far running a service ar for
logging onto other servers. Uze the Browse button to chooze wzers from pour nebworl:.
Far domainz, user names must be in the format of DOMAINW ] zerM ame.

User Mame: |insl:uriu:|ge Browsze. .. |

Pazzword: I [ IITTTYTY]

Create Mew zer..

YWize Inztallation YWizard [R]

Cancel |

< Back

Figure 5 Entering User Information for Insbridge

5. The next screen is the Logon Information screen. Please use the Insbridge user account information

that you set up for the initial installation. Click Next to continue.
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fit Oracle Insurance Insbridge Setup I =] |

Select Features C}RACLE‘

Pleaze select which features you would like toinstall. INSURANCE

Feature Description:

Oracle Inzurance Insbridge is a Web-based
rating, rules, and undenariting system,

- = 'I Qracle Bl Publizher A eports

Thiz feature will be inztalled on the lacal hard
drive.

| iz heature requires UKE an your hard drve. |t
haz 2 of 2 subleatures zelected. The
subfeatures free up B085KE on vour hard
drive.

Inztall location:
C:A\FPROGRARM FILESSORACLENGEUSMSERIDGEY

YWize Inztallation Ywizard [R]
Digk Cozt Reszet

Figure 6 Selecting Features to Install

6. The next screen lists the applications to be installed. To expand the options and view details, click on
the downward arrow. All features are checked for installation. RateManager is the only one that you
will be allowed to not install. Click Next.

Options are:

e Oracle Insurance Insbridge:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

o RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

NOTE: Do not install this option for SoftRater for Windows (SoftRater Node) updates.

e |IBFA:

- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher Reports:

- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

This option does not install the OBI Publisher. Only the templates required by the IBER application will be
installed on local hard drive.
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jig Oracle Insurance Insbridge Setup M= E3 |

Ready to Install the Application ORACLE

Click, Mext to begin ingtallation. INSURANCE

Click the Back button to reenter the installation information or click Cancel to exit
the wizard.

wize Inztallation \wizard [R]

Cancel |

Figure 7 Ready to Install

7. A Ready to Install screen is displayed. If you are ready, click Next. Otherwise click Back to check the

options you want to install. A progress screen displays your progress.

ji Oracle Insurance Insbridge Setup M=l B |

Updating System ORACLE

The featuresz you selected are currently being installed.
¥ ¥ hEnd INSURANCE

Yalidating prerequisites. ..

Time remaining: 13 seconds

Wize Installation Wizard [R]
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NOTE: If you receive a message that the system will need to be rebooted after the installation, STOP
THE INSTALLATION. This message means that the Insbridge Com + services are running. If
you get this message:

1. Stop the Installation.
2. Reboot the server.
3. Start the Installation over.

4. If the Insbridge Message Service is set to automatic, you must stop the service prior to running

the install.

8. When complete, a ReadMe Information screen is displayed.
i'.g!,! Oracle Insurance Insbridge Setup M =] |

4 Oracle Insurance Insbridge

Click the Finish buttaon to exit this installation.

ORACLE’

INSURANCE

Canzel |

¢ Back

Figure 8 Completed Installation

9. Click Finish to finish the installation. The installation should complete successfully.

25



Chapter 2 — Updating an Insbridge Application

STEP 3 — STARTING INSBRIDGE SERVICES

The Insbridge Message Service can be started on the server where Insbridge is installed or from the
Services screen in IBFA.

To start on the server go to Services and select to start Insbridge Message Service.

To Start in IBFA:

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly {process)

for execution. These processes may take resources and time to execute. Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating w | View Messages Edit Process Configuration

If vou see this message, you have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide yvou with a list view of the first in - first out mes=sages that are waiting to
execute.

Insbridge Task Manager Stop
The Insbridge Task Manager gives you the ahility to execute daily, weekly, hourly, ar by the minute,

View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 9 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Nextto Insbridge Message Service, click Start. After a few seconds, the buttons will refresh to

indicate that the service is started.

3. Next to Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

It is recommended that you also start the Insbridge Task Manager. The Insbridge Task Manager is a task
queue that lists the tasks that are scheduled to be performed as well as the last time the task was run and

the status.

NOTE: A login screen is displayed on IBFA for new installs. An upgrade does not reset the current

security setting. For example, if a login was not required for IBFA, upgrading to release 04.08.00

will not change that.
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STEP 4 — UPDATING DATABASES

Database updates can be performed in RateManager for the IBRM and IB_Client databases. This is the
recommended way to update these databases. If this is not possible, the SoftRater database can be
updated manually on the machine where they are located.

The SoftRater database needs to be updated manually on the machine where it is located.

To update the RM and IB_Client databases, log into RateManager.

NOTE: You must be a DB Owner to run the update scripts in RateManager.

NOTE: SoftRater update scripts must be run manually. See Manual Updates to the IBER Databases for
more information.

Updating Databases in RateManager

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where Installation server is
the server where RateManager was installed. This places you on the RateManager login screen.

If you log into RateManager and Tools is the only option, you must perform a database update.

= Oracle Insurance Insbridge RateManager 04.08 (10.100.10.10}-

ORACLE' Insurance Insbridge RateManager
File  Tools Help

Home [T

7| DB Update =]

a Please run the update scripts on the database.

Figure 10 Tool Mandatory Update

1. Enter your username and password.

2. Navigate to the Tools>Database>Updates.

On the DB Updates screen, the current version is highlighted and the status is Current. The
updates below the current version are grayed out. These updates cannot be run again. You will
receive an error message if you attempt to run a lower version update. Any version update above
the current version will also be grayed out but will be available for executing.

Updates have to be installed sequentially, meaning if you are on Version 03.13, you must run the

04.00 update, the 04.01 update, the next, and finally the 04.08.00 update. If you attempt to run an
update that is more than one level above the current version, you will receive an error message.

3. The Updates tab is displayed. Select the database you want to view from the Show updates for
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drop down. The database updates for your selection are listed. The last column, the Status
column, shows you which update is the Current one installed.

ORACLE" Insurance Insbridge RateManager

File

Home

Tools

DB Updates

(@ DB Updates

g Execute Update Script J'_E Open Update Script Save lpdate Script to File EE] Refresh

Show updates fof:| IERM W

Sonpt Release Date Database Status
wiO4,08.00.00 4/1/2014 IBR.M

wiO4.,07.00.00 3/1/2013 IBR.M

viO4.06.01.00 8/1/2012 IBR.M

vw04,06.00.00 3/1/2012 IBRM

wiO4.05.01.00 11/1/2011 IBR.M
viO4,00.0.00 3/10/2010 IBR.M

Figure 11 Available Updates

4. There are two ways to execute an update:

Directly in RateManager

a.

b.

In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This assures that the database showing as Current has all possible updates.

1.

2.

Highlight the update you want to run.

Click EXECUTE UPDATE SCRIPT. A warning message is displayed.

Click OK to run the update or Cancel to return to the previous screen.

Run all script in consecutive order until the 04.08.00 script is showing as current.

Do this for both the IBRM database and the IB_CLIENT database.

28



Chapter 2 — Updating an Insbridge Application

& | Confirm Update -- Webpage Dialog Iﬁ

™ Are you sure you want to replace the
current database's contents with the
_--/I selected release script on disk?

@ Ok | & cancel |

L

Figure 12 Updating Scripts in RateManager

6. Click File>Reload to refresh the system

In SQL Server

This method should be performed by a database administrator. No warning messages are displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating.
Please see Manual Updates to the IBER Database.

After you perform the database updates, to view all menu options, click File->Reload.

Updating a SoftRater for Windows Database

For release 04.08.00 SoftRater for Windows requires an update. The SQL database update file is located
in the IBER download—>Database—>SQL Server-> SoftRater — IBSR->Update folder. There are three
updates scripts.

e Upgrading from release 04.07.00 requires one update script be run, usp_IBSR_v04.08.00.00.sq|.

e Upgrading from release 04.05.01 or later, requires two update scripts;
usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sq|.

e Upgrading from release 04.05 or previous, requires three update scripts;
usp_IBSR_v04.05.01.sql, usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sql.

Update scripts need to be run manually by the DBA against the SoftRater database. No other steps are
needed.
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STEP 5 — UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager. Changes
will take place after the user sessions have been ended. If web settings are changed while the users are
inside the module, the change will not be visible to them. Prior to users accessing RateManager for the
first time, it is recommended that Preferences be set.

To Change Settings

1. Select Tools—>Preferences.

2. This opens the Preferences window. Select Web Settings.

- a p——— ~
Preferences
N Sf__nbnsgesr System Settings ~
© -Home Page
i--Administramr Inshridge Configurstion Fike Path: |C:\PROGRAM FILES\ORACLE\IGEU\INSERIDGE\FRAMEWORK\
- System Messaging Server: flocalhost | (Secure Channel) []
~Migrate Worldiles|  scfiRater Server : | HET[ v | |localhost | (secure Channel) []
Work Files Share Folder Location: | |
DB Backup Share Folder Location: |C:‘.,]nsbridge"\Backup |
Use Inshridge Com+ Admin: m
Enforce Release Packaging: IFalse w
Batch Package Threads:
Minimum Login User 1D Length: lzl
User must change password: (Days)
Show Override Date Mask: m
Allow Data Type Change: ITrue W
Inactive Sessicn Time Cut: E (hrs)
Batch Results with Newiline: m
Cnline Help Server: |kx,a|hcxst |
My Recent List:
< > Diefault Prowy Script Location: |hﬂ:p:,-",-'v.'pad,-‘wpad.da‘t | W
Channe Control: Onl
e  Save | @ Close |
h

Figure 13 Preferences Settings

3. Make any necessary changes. If you do not know all the settings, you can come back and edit lat
a later time. It is recommended that you update the ONLINE HELP Server immediately.

4. When you are finished, click SAVE to update your settings.
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Web Settings
Insbridge Configuration File Path

The path of the configuration file found in IBFA. This pathway must match the IBFA path. You may need
to change this path if you have changed the path in IBFA. Please contact Insbridge support for further
information.

It is strongly recommended that you leave the default.

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you have an
especially large batch to run and you want to batch to a different server, you will have to change server
locations here. Unless necessary, it is strongly recommended that you leave the default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Work Files Share Folder Location

A shared Workfiles location allows for multiple instances of RateManager to share the same Workfiles.
The IBER server and the shared location must be on the same domain. The Insbridge user must be on
the domain also.

For instructions on setting up a WorkFiles Share Location, please see the Inshridge WorkFiles Installation
Guide on the http://www.oracle.com/technetwork/documentation/insurance-097481.html|

DB Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, use a local path. If the location is not local, you must be a disk admin to change.

If the database is on a remote server, a share is needed for the backup location. The Insbridge user must
have write access to this location as well.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.
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If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True allows RateManager users change the data type of a variable or input. Setting
this option to False does not allow users to change data types.
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Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting places a
carriage return between result files. A False setting results in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting is the default server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

My Recent List

My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the
user recently worked on. You can set the maximum number of elements to display in a snap. The default
is for the snap list to be limited to 10.

Default Proxy Script Location

The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog
Feed snap. This setting can be used for RSS feeds.

Change Control

If change control is on, it is mandatory for users to enter a change control entry and justification to any
element or program when it is revisioned. If change control is off, the option is not presented.

Maximum Amount of Simultaneously Opened Tabs

Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you
allow users to have opened in RateManager. The default is 15.

Default Naming Standard

Select the Naming Standard to be applied system. If a Naming Standard is not needed system wide, clear
the field. The default is for the system default to be used. Please see Naming Standards for more
information.
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Enable Worksheet for Test Case Editor

Select true to have the option to create a rating or calculations worksheets in Test Case Editor. Select
false and the option to create a worksheet in Test Case Editor is not presented. Please see Worksheets
for more information.
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OPTIONAL STEPS

There are optional steps that can be performed for a RateManager/IBFA update.

OBI Publisher

e Step 1: Enter OBI Security Information

Migrating Files

e Step 1: Migrate Files

These steps may not be required, depending upon the actions you want to take.
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OBI PUBLISHER UPDATES

You will need to run this step if you are currently running release 4.7.0 or previous:

This step updates the OBI Publisher in RateManager and the corresponding IBFA from 4.7.0 or previous
to release 04.08.00 and assures that OBI is available to users.

e Step 1: Enter OBI Security Information

STEP 1 — OBl SECURITY

The OBI Publisher requires a default User ID and password to be entered in IBFA. OBI is required to
create certain reports in RateManager. Users will receive error messages if the OBl Publisher Credentials
are not completed.

E[3 Insbridge Configuration File [C:\PROGRAM
: FILES\ORACLE\IGBU\INSBRIDGE \Webs\IBFA\ Systems) SoftRater\Xml\rnxcoml]

Fleaze enter the SoftRater Explorer configuration information below.,

E-C3 SoftRater

""" 1 Engine

-8

1 SoftData Admin Email Address:

-l Services
B Logs
- Security
(;:) Softlibraries Internet Proxy: (®) None

@) Help O UserlD Password

Intranet Credentials: 'Zéi' Use Anonymous
() Domain UserID Password
OBI Publisher Credentials: UserlD Password
Save

Figure 14 OBI Publisher Credentials

1. On the left side menu, select SoftRater-> Explorer.
2. Locate the OBI Publisher Credentials.
3. Enter the default user name and password.

User ID: Administrator
Password: Administrator

4. Click Save to save your entry. You must click Save prior to exiting the page.
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Updating OBI Publisher Password

You can immediately update the OBI Publisher password if you want. The password must be updated in
OBI Publisher and then in IBFA.

1. Enter the OBI Publisher console. http://localhost:9704/xmlpserver where localhost is the machine
where IBFA/RM is installed.

2. Select the Admin tab.
3. Under Security Center, select Users.

4. Select the administrator Username.

TORACLE' Bl Publisher Enterprise

Welcome, administrator Preferences Sign Out Help

Reports | Schedules | Admin

| Admin = Users > Update User: administrator]

d User: administrator

P

Cancel I Apply

Username administrator
* Password

Figure 15 Updating the OBI Publisher Password

5. Enter in a new password and click Apply. This updates the Administrators password.
6. Sign out of OBI Publisher.
7. Enter IBFA.

8. Open the SoftRater Explorer Configuration window. Enter the same password in the OBI
Publisher Credentials.

9. Click Save. The password has been updated.

NOTE: A login screen is displayed on IBFA for new installs. An upgrade does not reset the current
security setting. For example, if a login was not required for IBFA, upgrading to release 04.08.00
will not change that.
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MIGRATE WORK FILES

This option migrates workfiles from previous versions of RateManager. This procedure is for updates from
release 13.7 or previous or if you are updating to a new machine. If you are updating from release 4.0 or
later and staying on the same machine, you do not need to migrate workfiles.

STEP 1 — MIGRATE WORK FILES

Migrating workfiles assures that previous workfiles are available to users. Workfiles are rating, pricing,

mapping and template files used in various areas of RateManager such as Impact Analysis, Library, and

Testing. Migrating files allows users to access work files that were available in previous releases of

RateManager. If you do not migrate work files from previous versions, users will not have access to them.

Work files should be migrated after the upgrade has been run.

File Edit ‘ew Favorites Tools Help

% My Documents H=1 E3
| &
N

2 Back - &3 - (B | - Search |FC Folders | (-

Address ID My Documents

8

Falders x

[=] “e Local Disk {C:) -
) dbB1b37074578FacdIFsc508
|5 Documents and Settings
| Downloads
= 1386
5 Inetpub

|5 InsbridgePackagelocation
=l I3 Program Files
15 cmak
I3 Comman Files
L) ComPlus Applications
=l 5 InsBridge
1) com+
I5) Framework
= 5K
I5) SoftRater
= I webs

T3 TBRU
=) rM3L0

=) rM312
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The location of previous RateManager installations:

-1 Program Files\InsBridge\Webs\RM:oox

where ¢ equals the version number

The current location of RateManager:

[ rRm¢ =————+1— Program Files\Oracle\IGBU\Insbridge\Webs\RM4

4]

Figure 16 Location of WorkFiles

Prior to migrating files, please create backup copies of the files to be migrated. This requires

access to the server were RateManager has been installed.
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File Location:

The location of the files to be migrated and the exact file name will depend upon what version of
RateManager you want to migrate. There are two possible locations.

For Release 3.12 and earlier:

e File Name: WorkFiles
e Location: \Program Files\InsBridge\Webs\RMxxx\WorkFiles

Where xxx is the version number, i.e. 310, 311, 312
For Release 3.13:

e File Name: Workfiles
e Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM313\W orkfiles

Copy all work files for every version to be migrated and store in a safe location. In the unlikely event that
an error with the migration occurs, you will have backup files that you can place directly in the
RateManager (RM4) Workfiles location or restore to the previous version.
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Performing the Migration in RateManager

This migration process moves rating, pricing, mapping, and template files from a previous version of
RateManager to the current RateManager version. You can select one version that you want to migrate. If
you have more than one version to migrate, you must perform the migration manually. Please refer to the
Installation and Upgrading Guide for instructions.

1. Select Tools=2>Preferences>Administrator=>Migrate Workfiles.

g . s
Preferences
-I-Settings . . . .
b User This option is used to transition test-case work files from the
previous Rate Manager installation to the current
i Home Page
=~ Administrator | Select to start migration .. |
g ystem
----- Migrate Workfile
< >
o Save | ) Cclose |

Figure 17 Migrating Work Files

2. Click the Select to start migration button. A separate screen is displayed.

3. RateManager determines the possible version to migrate. Select the version you want to migrate.
Only work files from the selected version will be migrated.
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[ a -- Webpage Dialeg ﬁ1

. Migrate Work Files
Migrate files from:

This migration process will move Rating, Pricing, Mappings and Templates from a previous version of
RateManager that you selected to current RateManager. This process could take 2 few minutes to
complete, An alert box will zppear when the process has completed.

Miglﬂtel @ Close |

L

Figure 18 Selecting Workfiles to Migrate

4. Click Migrate.
a -- Webpage Dialog Iﬁ

- Migrate Work Files

. Al current Rating, Pricing, Mapping and Template files wil be deleted in order
!_-/l to migrate the files from the previous RateManager. Do you want to
. continue?

L

Figure 19 Confirming a Migration

5. Click Yes to migrate. If you are unsure about the action you want to take, click No to stop the
migration process.

6. The migration will begin. This process could take a few minutes to complete. When all files have

been migrated, an information notice will be displayed.
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The process has campleted,

[ ]
Ly
v o |
Figure 20 Successful Migration

7. Click OK to close the screen.

Verifying Migrated Files in RateManager

Migrated files are available in the same areas.

@ Oracle Insurance Insbridge RateManager 04.08 (10.100.10.10) -

ORACLE Insurance Insbridge RateManager

File  Modules Tools  Help

| Home | gl Library x
‘ ol Library
 view: Wy Templates = New | #2) Upload from File | &5 Edit Details | [l save toFie | 3§ pelete | &) Refresh ;
Drag a column to this area to group by it. Search:
Name LoB Source Version | Version Name Effective Date Date Created
RC-BP-GA-09012012-V01 BOP ISO-ERC Vo1 BP-GA-09012012-V01 Jun 04 2013 10:03 PM e
RC-BP-AK-08012011-V03 BOP ISO-ERC Vo3 BP-AK-08012011-V03 Jun 04 2013 10:02 PM
RC-BP-AK-09012012-V02 BOP ISO-ERC Vo2 BP-AK-09012012-V02 Jun 04 2013 10:00 PM E
RC-BP-AK-09012012-V01 BOP ISO-ERC Vo1 BP-AK-09012012-V01 Jun 04 2013 09:46 PM
Auto Lab Auto Alamere z BI and PD Premium Nov 28 2012 03:45 AM
Insurance
050-448751-01 Auto Alamerelnsuran 1 Initial Nov 28 2012 12:04 AM
RC-BP-NY-05012012-V02 BOP ISO-ERC Vo2 BP-NY-05012012-V02 May 29 2012 08:58 PM
EQZ ErrorsOmissions LTS 1 Copy of EO1L May 10 2012 06:16 PM
Company
EQZ ErrorsOmissions Insurance 1 Copy of EO1 May 10 2012 04:50 PM
Company
BI_Prem Auto Alamere 1 May 03 2012 07:42 PM
Insurance
EQZ ErrorsOmissions Insurance 1 Copy of EOL May 03 2012 07:38 PM
Company
FLA_Auto Auto Alamere 1 Initial Apr 25 2012 11:03 PM
GLLab General Liability Alamere 3 Total GL Premium Apr 25 2012 11:01 PM
MultiLineTotals Multi-Line Alamere 1 Apr 19 2012 10:44 PM
Insurance
X99-360025-XX Auto Alamerelnsuran 1 XF_NODE Sep 12 2011 01:44 PM
X99-360025-XX Auto Alamerelnsuran 3 February Sep 12 2011 01:44 PM
X99-360025-XX Auto Alamerelnsuran 2 January Sep 12 2011 01:44 PM
050-448751-01 Auto Alamerelnsuran 3 February Sep 12 2011 01:44 PM
050-448751-01 Auto Alamerelnsuran 2 January Sep 12 2011 01:44 PM
050-448751-01 Auto Alamerelnsuran 1 Initial Sep 12 2011 01:43 PM
CONTROLLER General Liability Atlants Cantent Oct 28 2010 11:48 AM
Services -

Total Records: 134

Figure 21 Verifying File Migration in RateManager

To verify that work files from a previous version have been migrated, enter an area where these files
would be used, such as the Library tab.
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The tab refreshes with all available files. Your files from previous versions will be listed.

NOTE: Previous export files will not be migrated. Previous export files are not recognized in current
releases of RateManager.

Manual Migration

A manual migration must be performed under select circumstances. All versions must be on the same
server. If you are working with two separate machines, you must perform the migration manually. A
RateManager migration will perform a copy and paste of the WorkFiles on the server then the previous
versions WorkFiles will be deleted. This means that the version you select to be migrated will have the
WorkFiles deleted from the server. This cannot be reversed. Make sure this is the action you want to take.

If you have more than one version where you want to migrate files, you will have to perform the migration
on the server. DO NOT USE RATEMANAGER TO MIGRATE MULTIPLE VERSIONS. Only one version
can be migrated. If you attempt to migrate more than one version, you will write over any data with the
version that you are migrating. For example, if you migrate version 3.12 and then migrate 3.13, any
information from 3.12 will be written over with the information from 3.13. If you have more than one
version to migrate, you must perform the migration directly on the server.

Verifying the File Migration in the Server

Migrated files will be moved from previous releases into the updated RM4 Workfiles location.
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Figure 22 Verifying File Migration at Server Level

You can verify that files have been moved by looking in the
\Program Files\Oracle\IGBU\Insbridge\Webs\RM4\W orkfiles folder.

You also can verify that previous WorkFiles have been removed by looking in the prior WorkFile location
on the server.

Workfiles only need to migrated one time.
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UPGRADING TO A NEW MACHINE

If you are upgrading RateManager/IBFA from any previous release AND moving to a different machine
you will need to perform these steps. These steps will allow any packages loaded to the old machine to
be loaded and used by the new machine. If you do not perform these steps, old packages may not rate
properly or even be available to users.

NOTE: These steps need to be done only when you are migrating your RateManager/IBFA instance
from an old machine to a new machine.

o Step 1: Install RateManager/IBFA

o Step 2: Export the Insbridge Registry Key from the old Machine

e Step 3: Import the registry key from the old machine to the new machine
e Step 4: Copy the Insbridge XML file from the old machine.

e Step 5: Paste the Insbridge XML file in the new machine.

e Step 6: Finish the Installation

e Step 7: Run any needed Database Client — Optional

e Step 8: Manually Migrate Workfiles

After these steps, your RateManager/IBFA should be ready for use.

Step 1: Install RateManager/IBFA

A RateManager/IBFA upgrade that involves moving to a new machine is considered a new install. Please
follow the instructions for installing RateManager/IBFA in the RateManager Installation Guide.

STOP At Step 6 — Configuring Insbridge Framework Administrator.

Do not create a subscriber or environments.

Step 2: Export the Insbridge Registry Key

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE~>Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs).

When RateManager/IBFA is re-installed on a new server, a new registry key will be created. The new
registry key will not match the registry key associated with any packages that have been created on the
old machine. In order to load packages to the new machine, you will need to restore the previous registry
key.
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1. On the old machine, enter Registry Editor. Run->regedt32.

2. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.
3. Rightclick and select Export.

4. Select a storage location for the file and Save.

5. Close out of Registry Editor.

Step 3: Importing the Registry Key

The old registry key needs to be imported in to the new machine.
1. Save the Exported Registry Key to a location you can easily access.
2. Double click the Exported Registry Key. The key will be loaded.

3. Store the Exported Registry Key in a safe location.

Step 4: Copy the Insbridge. XML File

You can copy and paste the Insbridge XML file from the old machine to the new machine. This will allow
the environments and subscriber created in the old machine to be populated in the new machine.

NOTE: If you want to re-enter or re-create your environments, you can skip Step 4 and Step 5. After you
import the registry key, you will need to continue the RateManager/IBFA installation at Step 6 —
Configuring Insbridge Framework Administrator.

File Location:

The location of the Insbridge. XML file to be copied will depend upon what version of RateManager the old
machine is running. There are two possible locations.

For Release 3.12 and earlier:
e File Name: InsBridge.XML
e Location: D:\ProgramFiles\InsBridge\Framework\2.0.2\InsBridge.Xml.
OR C:\Program Files\Oracle\Insbridge\Framework\2.0.0\insbridge.Xml

For Release 3.13 and later:

e File Name: InsBridge.XML
e Location: C:\Program Files\Oracle\IGBU\Insbridge\Framework\3.5.0\Insbridge.Xml

Copy the Insbridge. XML file to a location you can easily access.

NOTE: If you are changing databases, you can copy and paste the Insbridge XML file, however you will
need to update your environments with the new database information.
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Step 5: Paste the Insbridge. XML File

Before pasting the Insbridge. XML file into the new location, make a copy of the blank Insbridge. XML file
and store in a safe location. In the unlikely event that an error occurs, you will have a backup file that you
can use.
The Insbridge. XML file in the New Machine is located:
C:\Program Files\Oracle\IGBU\Inshridge\Framework\3.5.0\Insbridge.Xml

1. Make a copy of the blank Insbridge.XML file on the new machine and store in a safe location.

2. Paste the Insbridge. XML file from the old machine in to the new machine in the same location.

3. Open an Internet Explorer web browser either remotely on the local IBER web server and browse
to IBFA location on the new machine: http://SERVERNAME/ibfa/

4. Subscribers and Environments should be available in IBFA on the new machine. Verify your
entries.

Step 6: Complete the RateManager/IBFA Installation

Complete the instructions for installing RateManager/IBFA. Please see the RateManager Installation
Guide for detailed instructions.

Continue at Step 7 — Verifying the Component Services. You will need to complete the rest of the
installation.

Step 7: Run Database Clients — Optional

This step is optional. You will need to run the Oracle Client or the DB2 Client if you are utilizing a Java
SoftRater, i.e. SoftRater for WebLogic, SoftRater for WebSphere or SoftRater for JBoss. The Oracle
Client is located in the Oracle Cloud Delivery package. The DB2 client is not included and must be
downloaded. For instructions on running the Oracle Client or the DB2 Client, please see the
corresponding SoftRater Installation Guide, i.e. SoftRater for WebLogic Installation Guide, SoftRater for
WebSphere Installation Guide or SoftRater for JBoss Installation Guide.

If you are running 64-bit, please make sure you use the 64-bit client.

Step 8: Manually Migrate Workfiles

After the installation has been completed, you will need to migrate workfiles. Follow the instructions for
Manually Migrating Workfiles, see page 36.

The RateManager system is ready for use.

NOTE: If users experience any difficulties with migrated packages, please verify that the database
usernames and passwords are entered for any SoftRater environment.
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IMPORTING REGISTRY KEY AFTER INSTALLATION

The registry key can be imported at any time after the initial RateManager/IBFA install and subscriber
creation. If the registry key needs to be imported after you have completed the installation and set up your
SoftRater environments, you will need to re-enter Database Username and Passwords for the SoftRater
Environments.

This procedure is only required if you have configured your environments. If you have not configured
your environments, you should not have to re-enter usernames and passwords for your environments.

Prior to starting, IBFA should be up and running on the new machine.

Step 1: Export the Insbridge Registry Key

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs).

When RateManagel/IBFA is re-installed on a new server, a new registry key will be created. The new
registry key will not match the registry key associated with any packages that have been created on the
old machine. In order to load packages to the new machine, you will need to restore the previous registry
key.

1. On the old machine, enter Registry Editor. Run->regedt32.

2. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

3. Right click and select Export.

4. Select a storage location for the file and Save.

5. Close out of Registry Editor.

Step 2: Importing the Registry Key

The old registry key needs to be imported in to the new machine.
1. Save the Exported Registry Key to a location you can easily access.
2. Double click the Exported Registry Key. The key will be loaded.

3. Store the Exported Registry Key in a safe location.

Step 3: Re-enter Username and Password

1. Enter the new IBFA instance.
2. Browse to SoftRater=>Explorer=>Subscriber name.

3. Select the Environments link under the Configuration header on the left hand side.
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4. You will notice that the database username and password entries will be blank. Please re-enter
the username and password. Test connections for any SoftRater environments.

5. Save your entries and close out of environments.

Upgrading the Database Machine

If you are upgrading your database machine, the new database information will need to be entered in
IBFA->Environments.
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MANUAL UPDATES TO THE IBER DATABASES

The preferred method of updating the IBRM and IB_CLIENT databases is to go into RateManager. If the
administrator has DB User privileges and is the DB Owner of the database as well as the disk
administrator, database updates can be done on the Tools=>Database->Updates tab. If these privileges
are not in place, an error message will be displayed. See Step 4 — Updating Databases for more
information.

NOTE: If you need to go from an older version, such as 03.13, it is strongly recommended that you enter
RateManager and run the script successively starting with 04.00, 04.01, and so on until you reach
the 04.08 script. Failure to run scripts in order may result in errors.

To manually update a SQL Server database, you will be required to save off each update and run them in
sequential order in SQL Server. A DBA or a person with the proper permissions will need to apply the
database updates in SQL Server using Query Analyzer.

1. First, you will need to get the scripts you need from RateManager.

2. In RateManager, highlight the update you need. Begin with the version that is listed as “current”.
If you are going from a much lower version of RateManager, you will have to save multiple files.

3. Click Save Update Script to File. Your computers dialog box is displayed. Save the file to a
location of your choice. For IBRM scripts, it is recommended that you rename the file to
usp_IBRM_R(version number).sgl. For example the Release 04.08.00 update would be:
usp_IBRM_RO04.08.00.sql. For IB_CLIENT scripts, it is recommended that you rename the file to
usp_IB_CLIENT_RO(version number).sgl. For example the Release 04.08.00 update would be:
usp_IB_CLIENT_R04.08.00.sq|.

4. Verify that you have saved all the necessary scripts from “current” to release 04.08.00. You must
save off update scripts for both the IBRM and the IB_CLIENT databases.

5. Next, enter SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following database
queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual database.

6. Begin with the current version of either the IBRM database or the IB_CLIENT database. Open
Query Analyzer.

7. Open up the DB script updates from the download file. You can open in any program you want,
such as Notepad. Begin with the “current” script. For example, if you are going from release 03.13
to 04.08.00, 3.13 should be “current”. Open 3.13 first.
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Figure 23 Updating Database

8. Select the database you want to update. In SQL Server Management Studio, create a new
Database Engine Query, File>New—>Database Engine Query.

9. Copy the first update from Notepad and paste onto the query screen.

10. Click Execute. The script will execute. Any messages will be displayed in the lower portion of the
screen. You must run the updates in sequential order. Run each update until you run the
04.08.00 update.

11. When you have finished updating one database, update the remaining database. Make sure you
do both the IBRM and IB_CLIENT databases.

12. After the scripts have been run, return to RateManager. Click Refresh Listing. The status should
show current and the full RateManager menu should be displayed. The updates are now properly
applied and users can log back in to the system.

NOTE: You can view the update script in RateManager. Select the update you want to view. Click Open
Update Script. Thehe update script will be displayed in a separate screen.
2 IBRU : vD4.08.00.00 -- Webpage Dialog -
€yclose
--5ET THE DATE FORMAT TO AN EXPECTED FORMAT TO SETUP THE SCHEMZ INPUTS
SET DATEFORMAT mdy A
GO
fx’KK!’x’!’!’!’!’!’!’K!’!’!’!’!’K!’!’x’x’x’x’x’x’x’x’x’x’x’x’x’
* LLTER TYPES ITEMS TABLE SECTICHN
!’x’x’KK!’!’!’!’!’!’!’!’!’!’!’!’!’!’!’x’x’x’x’x’x’x’x’x’x’x’x’f
IF OBJECT ID('PK_TYPES ITEMS', 'PE') IS NULL
ALTER TABLE [dbo].[TYPES ITEMS] ADD CONSTRAINT [PE TYPES ITEMS] PRIMARY
KEY CLUSTERED
[
[ID] ASC
JWITH (PAD INDEX = OFF, STATISTICS NORECOMPUTE = OFF, IGNORE DUF KEY =
OFF, ALLCW ROW LOCKS = ON, ALLOW PAGE LOCKS = ON) ON [PRIMARY]
GO v

b

Figure 24 Script Viewer
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Updating a SoftRater for Windows Database

For release 04.08.00 SoftRater for Windows requires an update. The SQL database update file is located
in the IBER download->Database—>SQL Server-> SoftRater — IBSR->Update folder. There are three
updates scripts.

o Upgrading from release 04.07.00 requires one update script be run, usp_IBSR_v04.08.00.00.sq|.

e Upgrading from release 04.05.01 or later, requires two update scripts;
usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sq|.

e Upgrading from release 04.05 or previous, requires three update scripts;
usp_IBSR_v04.05.01.sql, usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sql.

Update scripts need to be run manually by the DBA against the SoftRater database. No other steps are
needed.
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UPGRADING SOFTRATER FOR JAVA

How you upgrade SoftRater for Java depends upon what IBER release you are starting from:

Upgrading from Oracle Insurance Insbridge Enterprise Rating Release 3.13.4 or previous to
release 04.08.00 requires that the previous .EAR and config files be removed. The new .EAR file
then can be deployed. The application starting file must be updated as well.

If you are upgrading from release 3.13.5 or later, you need to redeploy the .EAR file and update
the application starting file. You do not need to redeploy the config file.

An update script must be run against the database being utilizing.

If you are upgrading from release 3.12 or previous you should check for SOAP changes. Updated
WSDL documents will need to be incorporated into any client calling application that
communicates with SoftRater. If upgrades are done to the SoftRater for Java engines without
updating the calling applications, the calling application will fail.

NOTE:

UPGRADE YOUR TEST ENVIRONMENT PRIOR TO PRODUCTION. Validate in test prior to
implementing in production.

Steps to Upgrade SoftRater for Java:

Every upgrade requires:

1. Update the application server. Please follow the instruction for the release your application
server is currently running.
e For Release 3.13.4 and Prior, delete the .EAR file and config file.
o For Release 3.13.5 and Later, delete the .EAR file only.
2. Deploy the new .EAR file.
3. Update the application starting file. Every SoftRater for Java requires a new property in the
start file of the application server.
4. Update the associated database. All database updates should be performed by your DBA or
qualified system administrator. This takes the SoftRater databases to release 04.08.00.
NOTE: Updates are performed manually on the database server.
5. OPTIONAL: Update the WSDL documents. You need to perform this step if you are currently

running release 3.12 or previous and incorporating a calling application. This allows your calling
application to function in the upgraded SoftRater. If you are not incorporating a calling application,
you will not need to do this step.
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SOFTRATER UPDATES

There are three SoftRater for Java engines:
e SoftRater for WebLogic
o SoftRater for WebSphere
o SoftRater for JBoss

The upgrade procedures to the application are similar and the upgrade procedure for the associated
databases is the same.

SOAP NOTICE

This notice is for customers currently running a SoftRater for Java engine:

o SoftRater for WebLogic

o SoftRater for WebSphere

o SoftRater for JBoss
Necessary updates have been made to the SoftRater for Java engines:

o SoftRater for WebSphere uses SOAP version 1.1.

o SoftRater for WebLogic uses SOAP version 1.1.

o SoftRater for JBoss uses SOAP version 1.1.
These changes mean that the WSDLs for the SoftRater for Java engines may have been modified since
the last installation of SoftRater for Java. Updated WSDL documents may need to be incorporated into
any client calling application that communicates with SoftRater. If upgrades are done to the SoftRater for
Java engines without updating the calling applications, the calling application will fail.
Please update a test environment prior to deploying to production. Install the .EAR file in a test

environment to obtain the WSDL. Update your calling application and then test again. When testing is
complete, you can upgrade your other environments.

NOTE: Customers running a Windows only environment, without a Java component, will not be affected.

These updates are for the SoftRater for Java engines only.
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UPGRADING WEBLOGIC

SoftRater for WebLogic can be upgraded any time after the IBER system. Prior to upgrading, download
the SoftRater for WebLogic Engine Setup zip file from the Oracle Software Delivery Cloud
https://edelivery.oracle.com. Unzip the file and place the contents for Release 04.08.00 in a location you
can easily access. File contents include:

e [IBSS.ear

o Insbridge.net.softraterconfig.xml

NOTE: If you are using a DB2 database, a system property must be added to the startWebLogic file.
Please see the SoftRater for WebLogic Installation Guide for complete instructions when utilizing
a DB2 database.

Upgrading from Release 4.7.x

This method removes the previous .EAR but leaves the config files. This upgrade does not require the
creation of an Instance folder. The configuration information will remain and does not need to be re-
entered in IBSS.

1. With WebLogic running, enter the console and delete the old IBSS.EAR file.

2. Stop the WebLogic Service.

3. On the server where WebLogic is installed, locate the configuration folder used in the previous
SoftRater for WebLogic installation. For example:

¢ InaWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

4. Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file and the
Jar file, if present.

5. Place the new IBSS.EAR file in the config folder. Once this file is in place, do not move.
6. Start the WebLogic server.

7. Enter WebLogic and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebLogic Installation Guide.

8. Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

9. Verify your entry and connections in IBFA.

10. Test your configuration and updated calling applications before deploying to production.
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Upgrading from Release 3.13.5t0 4.6.x

This method removes the previous .EAR but leaves the config files. This upgrade is for SoftRater for
WebLogics instances that do not have an Instance file. The configuration information will remain and
does not need to be re-entered in IBSS.

1. With WebLogic running, enter the console and delete the old IBSS_WL.EAR file.

2. Stop the WebLogic Service.

3. On the server where WebLogic is installed, locate the configuration folder used in the previous
SoftRater for WebLogic installation. For example:

¢ In aWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

4. Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file and the
Jar file, if present.

5. Place the new IBSS.EAR file in the config folder. Once this file is in place, do not move.

6. A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance
e For a Linux environment, home/ Insbridge/config/instance

7. A new system property must be added to the startWebLogic file. An Instance property is required.

Place this property after the -DINSBRIDGE_APP_D IR= property.
e -DINSBRIDGE_INSTANCE_APP_DIR="C:\Insbridge\Config| Instance". IT you

copy, please verify valid characters have been entered.
In this declaration, add a system property for the instance application directory to the
Java Virtual Machine using the “-D” parameter, then specify
“INSBRIDGE_INSTANCE_APP_DIR” as the name of the new variable.
You must also specify the path where the configuration file will be located. i.e.
“C:\Insbridge\Config\Instance”. Where C:\Inshridge\config\Instance is the folder you
created earlier.

For Linux ~-DINSBRIDGE_ INSTANCE_APP_DIR="/home/ INSTALLDIR/ Insbridge/Config/

Instance”

NOTE: Please see the SoftRater for WebLogic Installation Guide for assistance with editing the

startWebLogic file.

8. Start the WebLogic server.
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10.

11.

12.

Enter WebLogic and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebLogic Installation Guide.

Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

Verify your entry and connections in IBFA.

Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.4 or Previous

This method removes the previous .EAR and config files. The configuration information needs to be re-
entered in IBSS and validated in IBFA.

If you are using SQL Server, please see Preserving Environments for a SQL Server Upgrade on page 70.
The Preserving Environments for SQL Server Upgrade information allows you to keep your existing
environments by editing the config file.

1.

2.

3.

With WebLogic running, enter the console and delete the old IBSS_WL.EAR file.
Stop the WebLogic Service.

On the server where WebLogic is installed, locate the configuration folder used in the previous
SoftRater for WebLogic installation. For example:

¢ In aWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config

This same folder should be used for the update.

Within the configuration folder, locate the current Insbridge.net.softraterconfig.xml file and
make a back-up copy. The configuration information needs to be re-entered in IBSS. The updated
config file will not contain this information. This information cannot be directly imported but a copy
of the original file may be helpful when re-entering.

Delete the old config file, and the old .EAR file. You can leave the log file and the .jar file, if
present.

Place the new IBSS.EAR file and the new Insbridge.net.softraterconfig.xml in the config folder.
Once these files are in place, do not move.

A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For aWindows environment, C:\Insbridge\config\instance

e For a Linux environment, home/Insbridge/config/instance
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8. A new system property must be added to the startWebLogic file. An Instance property is required.
Place this property after the -DINSBRIDGE_APP_DIR= property.

e -DINSBRIDGE_INSTANCE_APP_DIR="C:\Insbridge\Config|Instance". IT you
copy, please verify valid characters have been entered.

In this declaration, add a system property for the instance application directory to the
Java Virtual Machine using the “-D” parameter, then specify
“INSBRIDGE_INSTANCE_APP_DIR” as the name of the new variable.

You must also specify the path where the configuration file will be located. i.e.
“C:\Insbridge\Config\Instance”. Where C:\Insbridge\config\Instance is the folder you
created earlier.

For Linux ~-DINSBRIDGE_INSTANCE_APP_DIR=*“/home/ INSTALLDIR/Insbridge/Config/
Instance”

NOTE: Please see the SoftRater for WebLogic Installation Guide for assistance with editing the
startWebLogic file.

9. Start the WebLogic server.

10. Enter WebLogic and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebLogic Installation Guide.

11. Enter IBSS. The previous entries will not be listed. You will need to re-enter the config
information. To verify the information, open the previous config file. Scroll to find SoftLibrary
information <lib_ref> and Environment information <connection name=>.

<lib n="0IFAStubAdaptor™ cls="oracle.insurance.pad.0IFALifeRdaptor™ 1="" d="2012-07-30 02:23:43 BM" 3="a" t="2">»
<arguments v="arga">
<arg n="strip-crlf"™ w="true" />
<arg n="stub-mode" w="true" />
<arg n="html-reprt” v="true" />
</argumentsr
</lib>

<1lib n="LOVIestScftData™ cls="com.oracle.igbu.activity.list0fValuesIkfaSoftDatalmpl™ 1="" d4="2012-10-05 07:13:45 AM" s="a" t="2">
<BrQUmEnt3 v="args">
<arg n="wadl-uri"™ v="http://10.100.10.100/ibfa/connectors/softdata.asmx?WSDL" />
</arguments>
</lib>

«1lib n="GetUserslctivityRdaptor™ cls="com.cracle.igbu.activity.GetUseraMockImpl™ 1=""

<1lib n="PolicySubmitMockImpl™ cls="com.oracle.igbu.activity.SubmitPolicyMockImpl™ 1="" d:
<arguments w="args" />
</lib>

<1lib n="Credit"™ cla="CREDIT.jar™ l="checked" d="2011-07-18 11:53:08 RM" 3="a" t="2" /><lib n="FProperty"” cls="Property.jar"” 1l="" d=
"2011-07-18 11:53:21 BM" s="d" t="2" /> S ftLIl ra ry I nf r atl n

<connection name="SR_PROD WL_l1" id="-99" provider="1" dbtype="R" uid="XXMX" pwd="mxxxuxxxxxxxx" dataServer="WINAPPOO7" dataSource=
"IBSE_Alamere"” port="1433" DataDir="C:‘Insbridge\S5R_Fackages." default="false" sgl_block_cnt="" dataSchemaz="" xdb_pl="1" />

</lib_ref>

<connection name="5R_PROD WL_2" id="-99" provider="2" dbtype="R" uid="XX¥X" pwd="mmxxuxxxuxxxx" dataServer="linappl0l.example.com"
dataSource="IBSR__ ALAMFERE 2" port="47479" DataDir="/home/Insbridge Fackage\"™ default="false" sgl_block cnt="" dataSchema="Insbridge™
xdb_pl="1" />

<connection name="SR_PROD WL_3" id="-99" provider="0" dbtype="R" uid="XXXX" pwd="mmxxxxxxxxxxx" dataSerwver="10.100.10.100" dataSourcg=

"IBSE_ALRMERE 3" port="50000" DataDir="C:\insbridge\sr_packages_ Alamere‘\™ default="false" s3gl block cnt="5" dataSchema="Insbridge”
xdb_pl="1" /></config>

Environment Information

Figure 25 Locating Information from Insbridge. XML File
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12. Verify your entry and connections in IBFA.
13. If necessary, obtain any WSDL information from IBSS and update any calling application.

14. Test your configuration and updated calling applications before deploying to production.
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UPGRADING WEBSPHERE

SoftRater for WebSphere can be upgraded any time after the IBER system. Prior to upgrading, download
the SoftRater for WebSphere Engine Setup zip file for your version of WebSphere from the Oracle
Software Delivery Cloud https://edelivery.oracle.com. Unzip the file and place the contents for Release
04.08.00 in a location you can easily access. File contents include:

e [IBSS.ear

o Insbridge.net.softraterconfig.xml

NOTE: If you are using a DB2 database, you will need to reconnect the DB2.jar to the ins.ru.ear file and
the Archetype Created Web Application using the Shared Library Reference section in
WebSphere. This connection is broken when the previous .jar file is deleted.

Upgrading from Release 4.7.x

This method removes the previous .EAR but leaves the config files. This upgrade does not require the
creation of an Instance folder. The configuration information will remain and does not need to be re-
entered in IBSS.

1. With WebSphere running, enter the console and delete the old IBSS_WS.EAR file.

2. Stop the WebSphere Service.

3. Onthe server where WebSphere is installed, locate the configuration folder used in the previous
SoftRater for WebSphere installation. For example:

¢ In aWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

4. Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file, if
present.

5. Place the new IBSS.EAR file in the config folder. Once this file is in place, do not move.
6. Start the WebSphere server.

7. Enter WebSphere and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebSphere Installation Guide.

8. Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

9. Verify your entry and connections in IBFA.

10. Test your configuration and updated calling applications before deploying to production.
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Upgrading from Release 3.13.5t0 4.6.x

This method removes the previous .EAR but leaves the config files. This upgrade is for SoftRater for
WebLogics instances that do not have an Instance file. The configuration information will remain and
does not need to be re-entered in IBSS.

1.

2.

3.

10.

11.

12.

13.

14.

With WebSphere running, enter the console and delete the old IBSS_WS.EAR file.
Stop the WebSphere Service.

On the server where WebSphere is installed, locate the configuration folder used in the previous
SoftRater for WebSphere installation. For example:

¢ In aWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file, if
present.

Place the new IBSS.EAR file in the config folder. Once this file is in place, do not move.
A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance

e For a Linux environment, home/ Insbridge/config/instance
Start the WebSphere server.
A new system property must be added to the Name Space Bindings.
INSBRIDGE_INSTANCE_APP_DIR. from the WebSphere Admin console, browse to the
following location:
Environment - Naming > Name Space Bindings
Change the scope to the Server level and click Apply.
Once you have changed to the server level, click New.
Select String and then click Next.
Create a Name Space Binding and Binding Identifier at the server level called
INSBRIDGE_INSTANCE_APP_DIR. The actual string value is the directory path location where
the Instance file was placed for example, C:\Insbridge\config\instance

Then select Next

Click Finish.
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15. After creating both the Name Space Bindings, Save to the master configuration.
NOTE: Please see the SoftRater for WebSphere Installation Guide for assistance with creatingName

Space Bindings.

16. Enter WebSphere and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebSphere Installation Guide.

17. Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

18. Verify your entry and connections in IBFA.

19. Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.4 or Previous

This method removes the previous .EAR and config files. The configuration information needs to be re-
entered in IBSS and validated in IBFA.

If you are using SQL Server, please see Preserving Environments for a SQL Server Upgrade on page 70.
The Preserving Environments for SQL Server Upgrade information allows you to keep your existing
environments by editing the config file.

1.

2.

3.

With WebSphere running, enter the console and delete the old IBSS_WS.EAR file.
Stop the WebSphere Service.

On the server where WebSphere is installed, locate the configuration folder used in the previous
SoftRater for WebSphere installation. For example:

¢ InaWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

Within the configuration folder, locate the current Insbridge.net.softraterconfig.xml file and
make a back-up copy. The configuration information needs to be re-entered in IBSS. The updated
config file will not contain this information. This information cannot be directly imported but a copy
of the original file may be helpful when re-entering.

Delete the old config file, and the old .EAR file. You can leave the log file, if present.

Place the new IBSS.EAR file and the new Insbridge.net.softraterconfig.xml in the config folder.
Once these files are in place, do not move.

A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.
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e For aWindows environment, C:\Insbridge\config\instance

e For a Linux environment, home/ Insbridge/config/instance

8. Start the WebSphere server.

9. A new system property must be added to the Name Space Bindings.
INSBRIDGE_INSTANCE_APP_DIR. from the WebSphere Admin console, browse to the
following location:

Environment - Naming - Name Space Bindings

10. Change the scope to the Server level and click Apply.

11. Once you have changed to the server level, click New.

12. Select String and then click Next.

13. Create a Name Space Binding and Binding Identifier at the server level called
INSBRIDGE_INSTANCE_APP_DIR. The actual string value is the directory path location where
the Instance file was placed for example, C:\Insbridge\config\instance

14. Then select Next

15. Click Finish.

16. After creating both the Name Space Bindings, Save to the master configuration.

NOTE: Please see the SoftRater for WebSphere Installation Guide for assistance with creatingName
Space Bindings.

17. Enter WebSphere and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebSphere Installation Guide.

18. Enter IBSS. The previous entries will not be listed. You will need to re-enter the config

information. To verify the information, open the previous config file. Scroll to find SoftLibrary
information <lib_ref> and Environment information <connection name=>.
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R s s .

<lib_ref>

<1lib n="0IFA3tubRdaptor™ cls="oracle.insurance.pad.0IFALifeRdaptor™ 1="" d="2012-07-30 02:23:43 RM" =
<arguments v="args">
<arg strip-crlfi™ v="true" />
<arg n="stub-mode"” w="trus" />
<arg n="html-reprt"™ v="true" />

" op=mary

</argumentax
</lib>
<1ib n="LOVTestScftData™ cls="com.oracle.igbu.activity.Llist0fValuesIkfaSoftDatalmpl™ 1="" d4d="2012-10-05 07:13:45 AM"™ s="a" t="2">
<arguments v="args">
<arg n="wadl-uri"™ w="http://10.100.10.100/ibfa/connectors/scftdata.asmx?WSDL" />
</arguments>
</Llib>
<1lib n="GetUserslctivityldaptor™ cla="com.oracle.igbu.activity.GetUzeraMockImpl™ 1="" d="2012-12-12 09:27:58 AM" 3="a" t="2" />

«1lib n="PolicySubmitMockImpl™ cls="com.cracle.igbu.activity.SubmitPolicyMockImpl™ 1="" d="2012-07-30 02:23:34 AM" a="a" t="2">
<arguments v="args" />
</lib>

<1lib n="Credit"™ cls="CREDIT.jar™ l="checked" d="2011-07-18 11:53:08 BM" s="a" t="2" /><lib n="Property"” cls="Property.jar" 1=

e SoftLibrary Information

</lib_ref>

<connection name="SR_PROD WL_1" id="-99" provider="1" dbtype
"IB3E_Alamere" port="1433" Datalir="C:‘\Insbridge\5F_Packages'\" default="false" sgl_block_cnt="" dataSchema="" xdb_pl=

uid="MHMN" pwd="HExEuixxxxxxxx" dataServer="WINAPPOO7" dataSource=
"

<connection name="5R_FROD WL_2" id="-99" provider="2" dbtype="R" uid="XX¥X" pwd="xixxuixixxxixx" dataServer="linappl0l.example.com"
dataSource="IBSR__ALRMERE 2" port="47479" DataDir="/home/Insbridge_ Package\" default="false" sql_block cnt="" dataSchema="Insbridge"
xdbk pl="1" />

<connection name="SR_PROD WL_3" id="-99" provider="0" dbtype="R" uid="XXXX" pwd="xxxxxxxxxxxxx" dataSerwver="10.100.10.100" dataScurcq
"IBSE_ALRMERE 3™ port="50000" DataDir="C:‘\insbridge\sr_packages_Rlamere\" default="false" 3ql block cnt="5" dataSchemz="Insbridge”
xdb_pl="1" /></config>

Environment Information

Figure 26 Locating Information from Insbridge. XML File

19. Verify your entry and connections in IBFA.
20. If necessary, obtain any WSDL information from IBSS and update any calling application.

21. Test your configuration and updated calling applications before deploying to production.
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UPGRADING JBOSS

SoftRater for JBoss can be upgraded any time after the IBER system. Prior to upgrading, download the
SoftRater for JBoss Engine Setup zip file from the Oracle Software Delivery Cloud
https://edelivery.oracle.com. Unzip the file and place the contents for Release 04.08.00 in a location you
can easily access. File contents include:

e [IBSS.ear

e Insbridge.net.softraterconfig.xml

NOTE: If you are using a DB2 database, a system property must be added to the server classpath.
Please see the SoftRater for JBoss Installation Guide for complete instructions when utilizing a
DB2 database.

Upgrading from Release 4.7.x

This method removes the previous .EAR but leaves the config files. This upgrade does not require the
creation of an Instance folder. The configuration information will remain and does not need to be re-
entered in IBSS.

1. With JBoss running, enter the console and delete the old IBSS_JB.EAR file.

2. Stop the JBoss Service.

3. On the server where JBoss is installed, locate the configuration folder used in the previous
SoftRater for JBoss installation. For example:

¢ InaWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

4. Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file, if
present.

5. Delete the old config file, the old .EAR file, and IBSS.EAR.deploy file. You can leave the log file or
README.txt file, if present.

6. Start the JBoss server.

7. Enter JBoss and deploy the new .EAR file. For help with installing the .EAR file, please see the
SoftRater for JBoss Installation Guide.

8. Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

9. Verify your entry and connections in IBFA.
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10. Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.5t0 4.6.x

This method removes the previous .EAR but leaves the config files. This upgrade is for SoftRater for
WebLogics instances that do not have an Instance file. The configuration information will remain and
does not need to be re-entered in IBSS.

1. With JBoss running, enter the console and delete the old IBSS_JB.EAR file.

2.

3.

Stop the JBoss Service.

On the server where JBoss is installed, locate the configuration folder used in the previous
SoftRater for JBoss installation. For example:

¢ In aWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file, if
present.

Delete the old config file, the old .EAR file, and IBSS.EAR.deploy file. You can leave the log file or
README.txt file, if present.

A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance
e For a Linux environment, home/ Insbridge/config/instance

A new system property must be added to the startJBoss file. An Instance property is required.
Place this property after the -DINSBRIDGE_APP_D IR= property.

e -DINSBRIDGE_INSTANCE_APP_DIR="C:\Insbridge\Config| Instance". IT you
copy, please verify valid characters have been entered.

In this declaration, add a system property for the instance application directory to the
Java Virtual Machine using the “-D” parameter, then specify
“INSBRIDGE_INSTANCE_APP_DIR” as the name of the new variable.

You must also specify the path where the configuration file will be located. i.e.
“C:\Insbridge\Config\Instance”. Where C:\Inshridge\config\Instance is the folder you
created earlier.

For Linux -DINSBRIDGE__INSTANCE_APP_DIR=*“/home/ INSTALLDIR/Insbridge/Config/
Instance”
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NOTE:

Please see the SoftRater for JBoss Installation Guide for assistance with editing the startJBoss
file.

10.

11.

12.

Start the JBoss server.

Enter JBoss and deploy the new .EAR file. For help with installing the .EAR file, please see the
SoftRater for JBoss Installation Guide.

Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

Verify your entry and connections in IBFA.

Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.4 or Previous

This method removes the previous .EAR and config files. The configuration information needs to be re-
entered in IBSS and validated in IBFA.

If you are using SQL Server, please see Preserving Environments for a SQL Server Upgrade on page 70.
The Preserving Environments for SQL Server Upgrade information allows you to keep your existing
environments by editing the config file.

1.

With JBoss running, enter the console and delete the old IBSS_JB.EAR file. If you do not use the
JBoss console, you can delete the old IBSS file after the service has stopped.

Stop the JBoss Service.

On the server where JBoss is installed, locate the configuration folder used in the previous
SoftRater for JBoss installation. For example:

e InaWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config

This same folder should be used for the update.

Within the configuration folder, locate the current Insbridge.net.softraterconfig.xml file and
make a back-up copy. The configuration information needs to be re-entered in IBSS. The updated
config file will not contain this information. This information cannot be directly imported but a copy
of the original file may be helpful when re-entering.

Delete the old config file, the old .EAR file, and IBSS.EAR.deploy file. You can leave the log file or
README.txt file, if present.

Place the new IBSS.EAR file and the new Insbridge.net.softraterconfig.xml in the config folder.
Once these files are in place, do not move.

A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
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have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance
e For a Linux environment, home/ Insbridge/config/instance

8. A new system property must be added to the startJBoss file. An Instance property is required.
Place this property after the -DINSBRIDGE_APP_DIR= property.

e -DINSBRIDGE_INSTANCE_APP_DIR="C:\Insbridge\Config|Instance". IT you
copy, please verify valid characters have been entered.

In this declaration, add a system property for the instance application directory to the
Java Virtual Machine using the “-D” parameter, then specify
“INSBRIDGE_INSTANCE_APP_DIR” as the name of the new variable.

You must also specify the path where the configuration file will be located. i.e.
“C:\Insbridge\Config\Instance”. Where C:\Insbridge\config\Instance is the folder you
created earlier.

For Linux -DINSBRIDGE__INSTANCE_APP_DIR=*“/home/ INSTALLDIR/Insbridge/Config/
Instance”

NOTE: Please see the SoftRater for JBoss Installation Guide for assistance with editing the startJBoss
file.

9. Start the JBoss server.

10. Enter JBoss and deploy the new .EAR file. For help with installing the .EAR file, please see the
SoftRater for JBoss Installation Guide. If you do not use the JBoss console, the .EAR file should
deploy when starting.

11. Enter IBSS. The previous entries will not be listed. You will need to re-enter the config
information. To verify the information, open the previous config file. Scroll to find SoftLibrary
information <lib_ref> and Environment information <connection name=>.
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<1lib ref>

<lib n="0IFA3tubRdaptor™ cls="oracle.insurance.pa3.0IFALifeRdaptor™ 1="" d="2012-07-30 02:23:43 BM" 3="a" t="2">
<arguments v="args">

<arg n="3trip-crli" v="true" />
<arg stub-mode ="true" />
<arg n="html-reprt"™ v="true" />
</argumentax
</lib>

<1lib n="LOVTestScftData™ clas="com.oracle.igbu.activity.list0fValuesIbfaSoftDatalmpl™ 1="" d4="2012-10-05 07:13:45 AM™
<arguments v="args">
<arg n="wadl-uri"™ w="http://10.100.10.100/ibfa/connectors/scftdata.asmx?WSDL" />

</arguments>
</Llib>
<1lib n="GetUserslctivityldaptor™ cla="com.oracle.igbu.activity.GetUzeraMockImpl™ 1="" d="2012-12-12 09:27:58 AM" 3="a" t="2" />
«1lib n="PolicySubmitMockImpl™ cls="com.cracle.igbu.activity.SubmitPolicyMockImpl™ 1="" d="2012-07-30 02:23:34 AM" a="a" t="2">
<arguments v="args" />
</lib>
<1lib n="Credit" cls="CREDIT.jar™ l="checked"” d="2011-07-18 11:53:08 BM" s="a" t="2" /><lib n="Froperty” cls="Froperty.jar" 1="" d=

"2011-07-18 11:53:21 AM" s="d" t="2" />

Softlerary Information

<connection name="SR_PROD WL_1" id="-99" provider="1" dbtype="R" uid="XXX" pwd="xxxxxxxixxxxxx" dataServer="WINAPPOO7" dataSource=
"IB3E_Alamere" port="1433" DataDir="C:‘Insbridge‘\5F_FPackages\" default="false" sgl_bklock_cnt="" dataSchema="" xdb_pl="1" />

</lib_ref>

<connection name="5F_FROD WL 2" i
dataSource="IB5SE__ ALAMERE 2" port="47479" DataDir=
xdb_pl="1" />

Uid="M3" pwd="XEXXixixxxxxx" dataServer="linappl0l.example.com”
/home/Insbridge_Package\™ default="false™ sql block cnt="" dataSchema="Insbridge"”

<connection name="SR_PROD WL_3" id="-99" provider="0" dbtype="R" uid="XXXX" pwd="xxxxxxxxxxxxx" dataSerwver="10.100.10.100" dataScurcg=
"IBSE_ALRMERE 3™ port="50000" DataDir="C:‘\insbridge\sr_packages_Rlamere\" default="false" 3ql block cnt="5" dataSchemz="Insbridge”
xdb_pl="1" /></config>

Environment Information

Figure 27 Locating Information from Insbridge. XML File

12. Verify your entry and connections in IBFA.
13. If necessary, obtain any WSDL information from IBSS and update any calling application.

14. Test your configuration and updated calling applications before deploying to production.

Common Errors

If you experience any deployment issues, look for a deploy fail file in the deployments folder. Delete the
deploy fail file and try again.
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Chapter 6 — SoftRater Updates

Preserving Environments for a SQL Server Upgrade

NOTE: You do not need to do perform this action if you are running release 3.13.5, or later. These steps
are not necessary if you do not want to keep your existing environments.

If you are utilizing SQL Server and want to keep your current Environment settings, you will need to edit
the insbridge.net.softraterconfig.xml file.

1. Deploy the new .EAR file.

2. Open the insbridge.net.softraterconfig.xml. The insbridge.net.softraterconfig.xml file will be
located in the folder you setup when you initially installed SoftRater for WebLogic. For example,
C:\Insbridge\config.

3. Make a back-up copy of this file.
4. In the insbridge.net.softraterconfig.xml file, find this section:

<jdbcDriver provider="1" name="SQLSERVER">
<jdbcDriverClassName>com.microsoft.jdbc.sqlserver.SQLServerDriver</jdbcDriverClassName>
<jdbcUrlPrefix>jdbc:microsoft:sqlserver://</jdbcUrlPrefix>
<jdbcFetchSize>25</jdbcFetchSize>

</idbcDriver>

And replace it with this:

<jdbcDriver provider="1" name="SQLSERVER">
<jdbcDriverClassName>com.microsoft.sqglserver.jdbc.SQLServerDriver</jdbcDriverClassName>
<jdbcUrlPrefix>jdbc:sqlserver://</jdbcUrlPrefix>
<jdbcFetchSize>25</jdbcFetchSize>

</jdbcDriver>

5. Restart the Application Server.
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UPDATING SOFTRATER FOR JAVA DATABASES

After the application servers have been updated, you may need to update the database servers. All
database updates for SoftRater engines must be performed manually. Upgrading from release 04.07.00
does not require an update.

SQL Server Update

SoftRater for Java utilizing a SQL Server database requires an update script be run against the SQL
Server database.

The SQL database update file is located in the IBER download->Database->SQL Server-> SoftRater —
IBSR->Update folder. There are three updates scripts.

o Upgrading from release 04.07.00 requires one update script be run, usp_IBSR_v04.08.00.00.sq|.

e Upgrading from release 04.05.01 or later, requires two update scripts;
usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sq|.

e Upgrading from release 04.05 or previous, requires three update scripts;
usp_IBSR_v04.05.01.sql, usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sql.

Update scripts need to be run manually by the DBA against the SoftRater database. No other steps are
needed.

Oracle Database Update

SoftRater for Java utilizing an Oracle database may require an update script be run against the Oracle
database. Upgrading from release 04.07.00 does not require an update.

The Oracle database update file is located in the Database-> Oracle-> SoftRater - IBSR->Update folder.
The file name is usp_IBSR_v04.07.00.oracle. Run the script against the database to update. No other
steps are needed.

DB2 Database Update

SoftRater for Java utilizing a DB2 database may require an update script to be run against the DB2
database. Upgrading from release 04.07.00 does not require an update.

The DB2 database update file is located in the IBER download—> Database—->DB2-> SoftRater —
IBSR->Update folder. The file name is usp_IBSR_v04.07.00.db2. Run the script against the database to
update. No other steps are needed.
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Inshridge Enterprise Rating System product, please log
a Service Request using My Oracle Support at https://support.oracle.com/.

Oracle customers have access to electronic support through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200

oracle.com
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